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RMS LOGIN AND SETTINGS 

LOGIN 

Logging into RMS, like many systems on campus, requires Multi-Factor Authentication (MFA): 

• Set up MFA  – please note this process can take 30 minutes or more 

• Contact IT Support for help at itsupport@ucalgary.ca  

To login into RMS:   

• Enter the following URL into your browser to open RMS. 

https://my.RMS.ucalgary.ca 

Access to RMS requires that the individual have the correct role or title in PeopleSoft. Once the person 

has the correct PeopleSoft role, PeopleSoft will grant or change the appropriate access in RMS. This is an 

automated process which happens nightly.  

PSAR – PeopleSoft Access Request 

hen a person changes roles within the university, they will lose existing permissions in PeopleSoft. If you 

must delegate signing authority to someone who does not yet have appropriate access in RMS, you 

must first ensure that they have the correct role in PeopleSoft. In either case, a request must be 

submitted through PSAR (PeopleSoft Access Request). 

This process may take 72 hours or more so it should not be relied upon for last-minute submissions. 

Initiate PSAR process 

Go to PSAR via MyUCalgary 

OR 

Submit request through IT 

Once the individual has the correct role in PeopleSoft, their role will be updated in RMS within 24 hours. 

It is a good idea to periodically check the status of your PSAR request to see where it is in the process 

(i.e., who needs to provide approval).  

 

http://www.ucalgary.ca/mfa
https://ucalgary.service-now.com/it
mailto:itsupport@ucalgary.ca
https://my.rms.ucalgary.ca/
https://portal.my.ucalgary.ca/psp/paprd/EMPLOYEE/HRMS/c/UC_PT_MSS_SECURITY.UC_MSS_SEC_REQUEST.GBL?PORTALPARAM_PTCNAV=UC_MSS_SEC_REQUEST_GBL_1&EOPP.SCNode=HRMS&EOPP.SCPortal=EMPLOYEE&EOPP.SCName=UC_PT_MSS_SECURITY&EOPP.SCLabel=Peoplesoft%20Access%20Requests&EOPP.SCPTfname=UC_PT_MSS_SECURITY&FolderPath=PORTAL_ROOT_OBJECT.CO_MANAGER_SELF_SERVICE.UC_PT_MSS_SECURITY.UC_MSS_SEC_REQUEST_GBL_1&IsFolder=false
https://ucalgary.service-now.com/it?id=sc_cat_item&sys_id=249cd80713a7da006603d7b2e144b046
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DASHBOARD FEATURES - LAYOUT 

 

 

 

 

 

The Toolbar contains elements that 
remain static and are available to the 
user at all times. 

 

The Log In Menu in the 
top menu toolbar, 
provides you with 
several options related 
to your profile.  

The RMS Logout is also 
available in the menu. 

 

The profile Edit feature is in 
the Dashboard Header. 

 

Clicking the Add New 
Content button displays 
options based on your role 
permissions for creating 
content such as new Post--
award records.  

 

The Left Navigation 
Menu provides access 
to research process 
and administration 
tools.  

The options that 
appear are 
dependent on your 
role and permissions. 

 

The Dashboard Things  
to do section is where you 
will find records that are in 
progress and need your 
attention  

The Recently edited list 
displays records recently 
edited by you.  
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DASHBOARD FEATURES - MENUS 

The Dashboard is where you will find menus related to your profile and settings. 

Person Data>People 

Profile information is populated daily from PeopleSoft. There are additional sections and fields where 

you can add more information. These sections pertain to your work affiliations, research, and provide 

more information about your professional accreditations. 

To edit your Profile information: 

1. Click Edit beneath your name in the dashboard banner. The PeopleData>Person page opens to 

the Key Information tab. 

 

 

Key Information tab 

 

In the Key Information tab, you can: 

• Enter IDs (e.g., ORCID, CIHR, NSERC, and SSHRC) 

• Add a secondary email 

• Add an URL if you have a site page 

• Add a profile picture  

This is also where you can add a Designate which we be covered later in this guide.  
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Work Affiliations 

 

a. The Work Affiliations tab displays the sequence for your affiliations and any Institute 

Memberships (Medicine). The Work Affiliation designated as #1 is the default at login. 

b. Click the blue pencil icon to open the Affiliations Details page where you can add telephone 

numbers or a website URL. Other fields auto-populated from PeopleSoft cannot be edited. See 

also WORK AFFILIATIONS for instructions on how to change a PI and related work affiliations for 

a record. 

 

 

TOGGLE EMAIL NOTIFICATIONS 

To toggle email notification settings: 

1. Click the dropdown arrow beside your login name. 

2. Click My Settings to open the menu. 

 

 

 

 

 

3. Check or uncheck the “Email” checkbox and then click 

Save. It is highly recommended that you keep this box 

checked so that you receive notifications from the system.  

a. b. 
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RMS ROLES 

Permissions to create, edit, and approve records in RMS are defined by role permissions.  

Roles are categorized according to organization (e.g., faculty, RSO), or individual (e.g., researcher). They 

are automatically assigned in RMS based on PeopleSoft job codes. Special circumstances may require 

manual assignment of roles.  

RMS access is governed by roles defined in PeopleSoft. If you must delegate signing authority to 

someone who does not yet have appropriate access in RMS, you must first ensure that they have the 

correct role in PeopleSoft. To do this, submit a request through PSAR (PeopleSoft Access Request). This 

process may take 72 hours or more so it should not be relied upon for last-minute submissions. 

Initiate PSAR process: Go to PSAR via MyUCalgary or Submit request through IT 

Once the individual has the correct role in PeopleSoft, their role will be updated in RMS within 24 hours. 

System roles do not equate to job titles. While role names maybe similar, they are not always the same. 

For example, a Team Member’s role permissions in PeopleSoft are not the same as a Team Member’s 

permissions in RMS. 

SWITCH ROLE 

In RMS, users may have multiple roles. For example, an Associate Dean Research (ADR) may also have 

the role of Researcher. This provides flexibility, but also has built-in rules for segregation of duties. While 

an ADR can create a record in RMS, they cannot approve their own record. 

If a user has more than one role, RMS defaults to the most frequently used role and typically the one 

with the highest level of permissions.  

To verify your RMS role: 

1. Click the dropdown arrow beside 

your login username.  

2. Select Switch Role from the menu 

list. 

3. Select a role.  

 

 

 

 

https://portal.my.ucalgary.ca/psp/paprd/EMPLOYEE/HRMS/c/UC_PT_MSS_SECURITY.UC_MSS_SEC_REQUEST.GBL?PORTALPARAM_PTCNAV=UC_MSS_SEC_REQUEST_GBL_1&EOPP.SCNode=HRMS&EOPP.SCPortal=EMPLOYEE&EOPP.SCName=UC_PT_MSS_SECURITY&EOPP.SCLabel=Peoplesoft%20Access%20Requests&EOPP.SCPTfname=UC_PT_MSS_SECURITY&FolderPath=PORTAL_ROOT_OBJECT.CO_MANAGER_SELF_SERVICE.UC_PT_MSS_SECURITY.UC_MSS_SEC_REQUEST_GBL_1&IsFolder=false
https://ucalgary.service-now.com/it?id=sc_cat_item&sys_id=249cd80713a7da006603d7b2e144b046
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WORK AFFILIATIONS 

Work affiliations accommodate circumstances where an individual has appointments in more than one 

department within a faculty or more than one faculty. 

RMS records can be associated with a specific work affiliation. 

To change the PI and work affiliation in a record: 

1. Within the post-award record, navigate to the Project Members section. 

2. Click the Trash icon to delete the current work affiliation for the record. 

 

 

 

 

 

 

3. Click the blue plus icon to add a new PI.  

 

4. Enter the name of the PI into the Keyword search field. A list displays with the individual’s work 

affiliations. 

 

5. Click the blue plus icon beside the work affiliation 

you want associated with this record. Details 

pertaining to the person auto-populate in the 

Principal Investigator fields. 

6. Click Save. 
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DESIGNATE 

As the PI, you may want to designate another person to provide assistance with your applications or 

projects in RMS. The Designate differs from the Team Member, in that the Designate has access to all of 

the PIs Pre-award and Post-award records. The Team Member is only assigned by the PI to specific 

records. Individuals that can be designated, must however, have a role as Team Member in RMS.  

Designates have access to pre-award/post-award equivalent to a Researcher where they can edit or 

contribute to a PI’s records when designated by the PI.  

Approvers (e.g., Department Head, ADR) do not have permission to add Designates. 

While Designates do not receive notifications, they can email contacts from within RMS.  

To add a Designate: 

1. Click Edit beneath your name in the dashboard banner. The Key Information page displays. 

2. Scroll down to the bottom of the Key Information page.  

3. Click the        icon at the bottom of the page below Designate(s). The search field displays. 

 

 

 

4. Click the        icon.  

5. Add the designate by clicking          icon 

beside the name of the person you 

want to add.  

 

6. Click Save to apply the change. The Designate can now view all Pre-award or Post-award records 

associated with the PI who added them as a designate. 
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LOCATING RECORDS 

There are a number ways to locate an existing record.  

MENU SEARCH 

The Post-award menu search feature lets you view and filter all Post-award records associated with your 

login permissions.  

1. In the Dashboard left pane menu, click Award Management. 

2. Click Post-Award/Projects. Post-award records display in the right pane.  

To open a file in this view: 

 Click Edit below the 

record to open this 

record.  

 

 

 

 

If you click on the title of the record or anywhere in the row except for the Edit button, you will only see the 

summary page. You cannot edit the record from the summary page.  

CONDUCT FILTERED SEARCH 

Filters are a powerful feature in RMS that allow you to quickly find records. The filtered search feature 

also lets you apply a saved set of search criteria for frequently used queries. You can apply a single filter 

or use multiple filters to refine your search.  

As with other functionality in RMS, role permissions determine what your search results will show you.  

 

1. Select from the left pane menu options Award Management>Post-

Award/Projects.  
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2. Click the Filter icon.  

3. Select the search parameters. 

 

 

4. Click Apply. The list displays based on the search parameters. 

5. Click Reset to reset or clear the filter. 

CONDUCT AND SAVE A MULTI-FILTERED SEARCH  

1. Select from the left pane menu options Award Management>Post-Award/Projects. 

2. Click the Filter icon in the right pane.  

3. Select the search parameters for the first filter. 

4. Click the Add Filter          

icon to add each additional 

filter.  

To save the filter: 

5. Click Save Filter. 

6. Enter a name into the 

Filter Name field. 

7. Click Save Filter. The list displays based on the filters. The filter icon changes from blue to amber 

to indicate the list is filtered. 

NOTE: The list remains filtered (and the filter button remians orange) until you click the Reset button.
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LOAD A SAVED FILTER 

Once a filter is saved, it can be quickly reloaded for future searches.  

1. Click the Restore Filter. 

2. Select the filter you want to use 

from the Filter name dropdown list. 

3. Click Load Filter.  

 

 

 

VIEW/PRINT POST-AWARD RECORD SUMMARY 

To view the summary for a Post-award record: 

 In the Dashboard, click Award Management in the left pane. 

 Click Post-

Award/ Projects. 

 

 

 

 

 

 Click the hyperlinked blue project title or anywhere within a record’s row to view the record’s 

summary. The Post-Award summary page opens.  

This view provides a summary of the record.  

To save a PDF version of the Post-award record: 

 Click Create PDF in the top right-hand side of the page banner. The 

saved PDF can then be emailed or printed.  

 

 

 

Click in the title or anywhere in 

the row to open details page 
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VIEW STATUS LOG FOR A RECORD 

The Status Log option in RMS, provides you with a view of the status change history for a post-award 

record. The status log indicates status changes for the record and the person responsible for the change 

and the date and time the change was made.  

Changes to content in the record are not tracked in the status log.  

To view the status log for a record: 

 Open any record you want to view that status log for.  

 This applies to: Pre-award/Application, Post-Award/Projects, Funding Opportunity or 

Agencies. 

 Click Admin info in the ribbon at the top of the window. 

 Click Status Log. The record’s log displays in descending order. 
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PI RECEIVES AWARD (Grant With an Existing RMS Pre-Award) 

You submitted a grant application using RMS. Your application was successful and you received a Notice 

of Decision from the funding agency. Typically, uploading the Notice of Decision is done by RSO however 

the PI can also do this.  

UPLOAD THE NOTICE OF DECISION 

To upload your Notice of Decision letter: 

1. Locate the Pre-Award record related to the successful award. See SEARCH FOR RECORDS.  

2. Open the record to edit it. 

3. Go to the Notice of Decision tab.  

4. Under the Notice of Decision outcome field: 

a. Select “Yes – funding was awarded” 

 

 

5. Click on the calendar icon under Decision Date and select the date of the 

decision.  

Note: The PI/Team Member cannot set the award start date, end date, or 

funding amounts. This must be done by RSO with the information found in the 

Notice of Decision or Notice of Award.  

 

 

 

6. Scroll down, under the Documents heading, click the folder icon to upload the Notice of 

Decision received from the funding agency. Select the Notice of Decision document type. 
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7. Click Save and then click Cancel to exit the record.  

 

 

The assigned RSO contact will receive a notification in RMS indicating that the Notice of Decision was 

received and whether funding was awarded.  

Note: The status will remain “Submitted to agency”. The PI/Co-I/Team Member cannot set the status 

to “Awarded”. RSO changes it to “Awarded” once they review the Notice of Decision. 

Once RSO changes the status to Awarded, RMS will automatically create a post-award record.  

START

Notice of 
Decision 
Received

RSO sets 
status to 
Awarded

RMS Creates 
Post-Award 

Record

RSO 
completes 
post-award 
initiation

POST-AWARD 
INITIATION PROCESS

RSO or PI 
uploads 

Notice of 
Decision

Information required 
from PI?

Yes

Record is 
returned to 

PI for 
information

PI returns 
record to 

RSO

RSO assigns 
to Grants 
Officer

If needed, 
For 

approval by 
RSO 

No

PI adds 
required 

information

This may include:
• Ethics attestations and certificates
• Budget and other documents
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SETUP POST-AWARD PROJECT (Grant with Pre-Award) 

When the post-award record is created, RSO will initiate the post-award project. Once this is done, the 

PI, designate of the PI or team member (who is listed on the record already) must open the record and 

complete things like upload budget documents, attest to certifications, upload other documents, etc.  

The process of setting up a Grant with Pre-Award is similar to the process of setting up a Grant without 

Pre-Award. In the following sections, the differences between the two will be highlighted and will link to 

the applicable sections in the document. 

BUDGET DISTRIBUTION 

1. Starting from the Quick Entry Tab, scroll down to the budged distribution heading.  

 

 

Specify the budget distribution for the project. Depending on the chosen budget distribution, you may 

be required to attach a budget document to the project.  

2. Select a budget distribution 

according to the project. 

 

 

 

• If a budget document was submitted to the funding agency, select Use budget distribution 

submitted to funding agency. This must be uploaded to the DOCUMENTS section below. 

• If the Project Maintenance standard budget was used, select Use Project Maintenance 

standard budget distribution and no additional budget documentation is needed. 

• If the Project Maintenance budget template is used, select Other. This must be uploaded to 

the DOCUMENTS section below.  

A budget template can be found by clicking on the link in the help text directly above the budget 

distribution dropdown.  

DOCUMENTS SECTION 

The Documents section is where you will upload documents like an agreement, statement of work, 

budget, etc. See the section below on how to upload DOCUMENTS. The process is the same as below.  
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KEY INFORMATION TAB 

1. Navigate to the Key Information tab.  

 

 

 

2. Review the information in the Funding Opportunity field and in the Funding Agency/Sponsor 

field. Update only if necessary however these should be automatically transferred from the Pre-

Award application. 

3. Under the Short Project Title heading you may enter a Short Project Title for identification in 

PeopleSoft system – if not, PeopleSoft will use the first 30 characters of the full title. 

 

 

4. If not already done by RSO, enter a Start and End date for 

your Project. These must match the information on the 

Notice of Decision.  

 

 

 

ADD/REMOVE PROJECT MEMBERS 

The Project Members section is where you can add/remove people from the record. See the section 

below on how to ADD/REMOVE PROJECT MEMBERS.  

AWARD MANAGEMENT 

Researchers can link together their related pre-award and post-award projects if they choose to do so. 

Linking related post-awards will typically be used to link multi-stage applications together. 

1. While editing a post-award records, click on the Award Management tab.  

 

 



RMS POST-AWARD LEARNING GUIDE 
 Last Updated: November 19, 2021 

19 | P a g e  
 
 

2. Click the blue plus icon to add either (or both) related Pre-

Award/Application(s) or Related Post-Award/Projects. The 

list of items displayed are the pre or post-award projects 

related to that PI.  

• Records in which the you are listed as the PI, 

Co-I or a team member, or; 

• Records related to a PI whom you have been set as a designate.  

3. To search for a specific record, use the search field, or to browse all record connected to your 

account, click the A-Z icon. 

4. Click the blue plus icon beside the record(s) you want to relate to this project. 

ADDING CERTIFICATIONS 

Navigate to the Certifications tab. See section ADDING AND/OR REMOVING CERTIFICATIONS.  
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PI RECEIVES AWARD (Grant Without an Existing RMS Pre-Award) 

If a project received funding that did not require the submission of an award application through RMS, a 

Post-Award project must be created. In these cases, the award has no affiliated pre-award record. 

These instructions are for the PI however a Team Member can also create this type of record.  

CREATE NEW POST-AWARD PROJECT (Grant without Pre-Award) 

To create a new Post-Award: 

1. Click the +Add New Content button in the top right-hand 

corner of the dashboard. The click Award Management → 

Post-Award/Project 

 

 

 

2. Click Research Project → Grants & Award → Grant without Pre-Award → Grant without Pre-

award 

 

 

 

 

 

 

 

ADD EXISTING FUNDING OPPORTUNITY AND FUNDING AGENCY/SPONSOR TO A POST-AWARD 

RECORD 

The next step is to search for and select the Funding Opportunity.  

To search for an existing funding opportunity in RMS: 

1. Click the        icon under Funding Opportunity to add the funding 

opportunity.  
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2. Search for the funding opportunity 

that corresponds to the information in 

the NoD. You can type the name in the 

search field, or to browse all funding 

opportunities, click the         icon. 

3. Click the        icon beside the funding opportunity to add it to the record. 

 

Note: If the Funding Opportunity has a funding agency/sponsor connected to it already, this section 

will autopopulate with that funding agency and you do not need to add one. If it does not 

autopopulate, click the Save button to force that function. Otherwise, you can manually add a funding 

agency (see below). 

4. If nothing is listed under the Funding Agency/Sponsor 

heading, click the plus icon to add one.  

 

 

5. To search for a specific funding agency/sponsor, type the name in the search field, or to browse 

all, click the A-Z icon. 

 

 

 

6. Click the plus icon beside a funding agency to add it to the record.  

 

 

CREATE NEW FUNDING OPPORTUNITY 

The Research Services Office enters most funding opportunities into the Funding Calendar which 

become accessible in RMS. If a Researcher identifies a new funding opportunity and can’t find it in the 

funding calendar or RMS database, a new one is created. This typically occurs for small, one-off funding 

opportunities.  

To add a new funding opportunity in RMS: 

1. Click the          icon below the Funding Opportunity section. The text entry 

field will display. 
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2. Click the          icon beside the Funding Opportunity entry field. The New Funding Opportunity 

window opens.   

 

 

3. Enter the funding opportunity name into the Program Name field.  

 

 

4. If the opportunity is connected to an existing agency, click the          icon to add the agency.  

5. If known, add any other information about the funding opportunity to the Key Information 

and/or Details tabs.  

6. Click Save & set status when complete.  

 

 

7. Click For Intake by Research Services. Then click 

Save & set status.  

 

 

 

 

CREATE NEW FUNDING AGENCY/SPONSOR (AGENCY)  

To add a new agency related to the funding opportunity within a Post-award record: 

1. Click the         icon below Funding Agency/Sponsor. The 

search options display.  

 

 

2. Click the         icon to add a new 

agency. The New Agency 

window opens. 
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3. Enter the agency’s name into 

the Operating as field. This is 

name that is used to conduct 

business and maybe an 

abbreviated form of the legal 

name. 

4. Click the dropdown arrow in 

the Type of agency (source) 

field to select a type.  

5. Enter the website URL for the 

agency in the Link to Agency 

field. 

6. Enter any relevant details into 

the Notes field. 

 

7. Click Save & Set Status.  

 

 

8. Select For review by Research Services.  

9. Click Save & Set Status. 

 

 

 

 

 

ADDING ADDITIONAL POST-AWARD DETAILS 

1. Under the Full Project Title heading, type the 

project title.  

You may also enter a Short Project Title for 

identification in PeopleSoft system – if not, PeopleSoft 

will use the first 30 characters of the full title. 

 

 



POST-AWARD LEARNING GUIDE 

24 | P a g e  
 

2. Enter a Start and End date for your Project. These must 

match the information on the Notice of Decision.  

 

 

 

ADD/REMOVE PROJECT MEMBERS 

The person who creates a pre-award or post-award record will automatically be listed as the PI. If 

someone other than the PI is creating a record, they must remove themselves from the PI position and add 

the correct person to the record.  

A Co-investigator is typically someone who makes a significant contribution to the intellectual direction 

and/or conducts research or research related activities. They may also have responsibility for financial 

aspects of research. 

Team Members typically provide administrative support and may include collaborators, research 

assistants, postdocs, or other associates. 

PI’s can add Co-investigators and Team Members to edit or contribute to a RMS record if they have the 

role of Researcher or Team Member in RMS. They can also submit the record for approval to the PI.  

To add project members to a post-award project: 

1. Click the         icon below UofC Principal Investigator, the Search field 

displays. 

2. Enter the name of the person in the Keyword search field, or click the          icon and select a 

name from the displayed list. 

 

3. Click the         icon beside the 

person's name in the list to 

add them into the record.  

 

 

Note: If you are creating a record and you are NOT the PI, you must replace yourself with the correct 

PI.  
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4. If the award is in a trainee's name, e.g., a studentship or fellowship, provide information about 

the trainee. Otherwise, leave these fields blank. 

 

 

 

 

 

 

Note: You can also add UofC Co-Investigators, UofC Participant/Team Members or Affiliated UofC 

Institutes here. You cannot add people who are not in the University of Calgary system (e.g., a co-

investigator from another university).  

5. Add any UofC Co-Investigator or UofC Team Members. Use the same 

method as above to add people. Only people in the University of 

Calgary system can be found in RMS.  

 

 

 

6. If the application is led by another institution, provide 

information about the non-UofC principal investigator and 

institution. Otherwise, leave these fields blank.  

 

 

 

7. Answer the two Project Information questions.  
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FINANCIAL AND BUDGET 

Under the Financial heading you can specify how much money was awarded for each year of the project, 

according to the Notice of Decision. The Budget heading is where you will specify the budget distribution 

for the project. Depending on the chosen budget distribution, you may be required to attach a budget 

document to the project.  

1. Select the currency from the Currency dropdown. By default, Canadian Dollars are selected.  

 

 

 

 

 Enter the amount of funds awarded for each year of the project, as stated in the Notice of 

Decision. Do not use commas or dollar signs, only enter a numeric value for each year. 

 

 

 

 

 

 

Note: Clicking Save (at the bottom of the page) will calculate the total and put it in the Total Awarded 

field. 

 Select a budget distribution 

according to the project. 

 

 

 

 

• If a budget document was submitted to the funding agency, select Use budget distribution 

submitted to funding agency. This must be uploaded to the documents section below. 

• If the Project Maintenance standard budget was used, select Use Project Maintenance 

standard budget distribution and no additional budget documentation is needed. 

• If the Project Maintenance budget template is used, select Other. This must be uploaded to 

the documents section below.  
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CERTIFICATIONS 

1. Select either Yes or No to the questions in the Certifications section.  

 

 

 

 

 

2. Under the Applicable Certifications (IRISS) heading, attest to each question about human and 

animal ethics.  

 

 

 

 

 

 

 

 

 

 

 

• ‘Yes’ means the project requires that type of certification (REB or ACC) and the certificates 

are ready to be attached. You cannot progress this record unless you attach the appropriate 

certificates.  

• ‘No’ means the project requires that type of certification however one or more of them may 

not be ready yet. You can progress this record and attach the appropriate certificates later.  

• ‘N/A – none required’ means this project has no requirement for ethics certifications.  

If needed, you can add comments about your ethics certifications plan or situation in the text field below 

the attestation questions.  

3. To attach an IRISS certificate, click the plus icon below Applicable Certifications (IRISS).  
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4. To search for a specific certification, type the name of the certificate in the search field, or to 

browse all available certificates, click the A-Z icon. 

 

 

 

 

 

5. Click the blue plus icon beside the 

certificate(s) you want to attach to 

the project.  

 

Note: Your project may qualify for Early Release of Funds, which allows access to a maximum of 50% 

of your total budget for certain start-up expenses prior to your certificate(s) being approved. If the 

project qualifies for ERF, you have up to 6 months to obtain certification approvals and associate them 

in RMS. 

Note: The certificates chosen here need to reflect what the PI needs according the award/project. In 

order to access ALL funds for research purposes, certificates in IRISS must be identified (are Approved 

and Active), and the questions above MUST be answered affirmatively or as not applicable. 

Note: A researcher will only be able to see certificates attached to their name or where they have 

been listed as a Co-Investigator on other certificates. 

NOTE: A PI can view their Biosafety permit at anytime from their profile view on the dashboard.   

REMOVING CERTIFICATIONS 

Once certificates have been added to a record, they can be removed by clicking the trash can icon to the 

right of the certificate.  

Certificates are loaded into RMS from IRISS nightly. 
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DOCUMENTS SECTION 

The Documents section is where you will upload a copy of the Notice of Decision and other documents 

(e.g., agreements, statement of work, budget, etc.).  

1. Click the folder       icon in the Documents section. The Windows File Explorer window opens. 

2. Select the document and click Open in the File Explorer window.  

3. Select the type of file from the Type dropdown list. 

4. Click Save. The date is populated into the Uploaded on field. 

 

 

 

 

 

5. To delete a document, click the trash can icon to the right side of the document.  

 

Note: The blue arrows icon (for uploading a new version of the document has been removed). To add 

a new version, simply upload it following steps 1-4.  

 

CERTIFICATIONS TAB 

1. Navigate to the Certifications tab.  

 

 

2. Answer the question about clinical trials.  

 

 

By default, the system puts whoever created the record as the Biosafety permit holder. It is important to 

have the correct person as the permit holder or there will be an error when the project is setup in 

PeopleSoft which may result in delayed early release or full release of funds.  
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3. Under the Biosafety Permit (Biologistix) heading is listed the permit holder and the details of 

the permit. Only RSO can adjust this so if you notice the incorrect person, notify RSO and 

provide the correct permit holder. 

 

NOTE: For a Grant without an existing RMS Pre-Award, the PI will not see the permit attached to the 

record. For a Grant with an RMS pre-award, the PI will see their permit on the Quick Entry tab.  

NOTE: A PI can view their Biosafety permit at anytime from their profile view on the dashboard.   

 

AWARD MANAGEMENT 

Researchers can link together their related pre-award and post-award projects if they choose to do so. 

Linking related post-awards will typically be used to link multi-stage applications together. 

1. While editing a post-award records, click on the Award Management tab.  

 

 

2. Click the blue plus icon to add either (or both) related Pre-

Award/Application(s) or Related Post-Award/Projects. The 

list of items displayed are the pre or post-award projects 

related to that PI.  

• Records in which the you are listed as the PI, 

Co-I or a team member, or; 

• Records related to a PI whom you have been set as a designate.  

3. To search for a specific record, use the search field, or to browse all record connected to your 

account, click the A-Z icon. 

4. Click the blue plus icon beside the record(s) you want to relate to this project. 
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UPDATING ETHICS CERTIFICATIONS 

See CERTIFICATIONS, REMOVING CERTIFICATIONS 

 

 

SAVE, CLOSE, OR REOPEN A RECORD 

In every application there are best practices to prevent data from being lost. Frequent saving is one 

practice that can prevent data loss. Leaving unsaved records open at any time puts your data at risk.. 

SAVING AND SETTING THE STATUS OF A POST-AWARD RECORD 

At any time, you can save your work, exit (cancel) without saving your work or save and set the status of 

the record.  

To save a record and keep its current status: 

1. Click Save. 

2. The click Cancel. The record will close and will maintain it’s current status. 

 

 

 

LOCKED RECORD 

Records with a status of either In Preparation or Submitted for Approval cannot be edited by two users 

at the same time. The records can be viewed, but not edited. 

If you open a record and attempt to edit and save changes to a record that is open by another user, you 

will receive the message currently being edited by.  
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If a user needs immediate access to a record, they can message the person (e.g., PI, Team Member, or 

Co-I) from within the RMS record and request they log out of the record. From within a record, click the 

mail icon beside a person’s name to send a message to that person.  

 

When a record is in Submitted for Approval status, the approvers are identified in the Academic 

Approvals section but there is not an option within RMS to send a notification. Approvers that have a 

record open, can be contacted via email, phone or in-person.  

 

 

OPEN AND EDIT RECORD FROM DASHBOARD LIST 

If you are working in a record, and need to close and finish later, the details below provide instructions 

for opening and editing a record.  

To open and edit a Draft Post-award record from the Dashboard: 

1. In your Things to do list, click Draft Post-award/projects for completion. 

 

 

 

 

 

2. Click the hyperlinked title of a record in the list. The record opens and you can continue 

completing the record. 
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VIEW OR EDIT A POST-AWARD RECORD FROM THE POST-AWARD/PROJECTS MENU 

Draft/In Preparation records do not display in a Designate’s dashboard. Designates view the records from the Post-

award menu list. They can view Post-award records they, or the PI have recently edited in the Dashboard>Recently 

Edited section. 

To view/edit a record from the Post-award menu list:  

1. In the left menu, click Award Management>Post-

award/Projects. 

 

 

2. Click Edit below the record you wish to view or edit.  

 

 

 

 

 

 

 

 

To progress a Post-award record to For intake by research services. 

1. Click Save & Progress.  

 

 

2. Select For intake by research services. 

3. NOTE: ‘In preparation’ status is the default status populated by the system. You must 

intentionally select ‘For intake by Research Services’ in order to advance the record for 

academic approval.  
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4. Click Save & Set Status. 
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POST-AWARD APPROVALS 

If a post-award/project did not have a pre-award application process (in RMS or otherwise), the project 

will need to get academic approvals before it can begin processing through RSO and Project 

Maintenance.  

University policies based on regulatory or audit requirements and risk mitigation practices, govern 

approval workflows. RMS embeds the approval workflow based on those policies. 

• Typical approval workflows include two-level approval (i.e., departmentalized faculty approvers 

would include Department Head and Associate Dean Research (ADR)), as determined by the 

faculty.  

• There is also the potential for tri-level approvals. For example: 

• applications with special requirements require additional review from the Research 

Administrator for Medicine, Veterinary Medicine, and Kinesiology faculties 

• Approvers (e.g., ADR) with a dual role of Researcher cannot create and approve their own 

records where they are named as the Principal Investigator (PI).  

• Team Members can only submit a record to a Principal Investigator (PI) for approval. 

 

AUTOMATED APPROVAL NOTIFICATION 

In a scenario where the Team Member has submitted the Post-award record, the PI is the first approver. 

The PI will receive a notification that alerts them to a Post-award record that requires approval. The 

subsequent people listed in the approver chain will receive similar notifications when it is their turn to 

approve.  

To view a notification alert: 

1. Click the Notification        icon. The notification preview 

displays. 

2. Click the blue hyperlinked summary to open the full 

notification. 

 

 

To open a notification from the Notifications menu: 
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1. From the Dashboard, click Notifications in the left pane. Notifications display in the right pane. 

 

 

 

 

 

 

 

2. Click the hyperlink title to open the record. 

3. To locate the record, see SEARCH FOR RECORDS 

Note: The request for approval notification is generated by the system and therefore you cannot reply 

to it. A message from another person in the system will show as a notification and has the added feature 

to reply to it. See NOTIFICATIONS: SEND AND REPLY 

 

APPROVING (OR NOT APPROVING) A POST-AWARD RECORD/PROJECT 

1. Under your Things to do list, click on Post-

Award/Projects pending approval. 

 

 

2. Click on the blue hyperlink of the record you want to approve. The approval summary page 

opens.  
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3. From this page, the approver can add a comment in the Approver comments field.  

4. The approval summary page is the only page you can approve a record from. From this page, 

you can do several things. You must return to this summary page to do any of the following 4 

options:  

• To review the record (before approving), click the blue pencil icon to the right of the Post-

Award/Project name. 

o You can only review information on this page 

(cannot edit). Click Cancel & Return to return to 

the approval summary page. 

• To approve the record, click Save & Progress. 

o Then select Approved. Then click Save & set 

status.  

• To not approve the record (and return it to the PI), 

click Save & Progress. 

o Then select Not approved. Then click Save & 

set status.  

o This will remove any previous approvals 

meaning that the same person will need to 

reapprove it once it is submitted again.  

• If the record required further information, click Save & Progress. 

o Then select Return to PI for further information. Then click Save & set status.  

o The record will return to the PI’s Things to do list under Post-Award/Projects requiring 

further information from PI (for approver) 

 



POST-AWARD LEARNING GUIDE 

38 | P a g e  
 

PI RESUBMITS RECORD FOR APPROVAL WITH INFORMATION REQUESTED 

When the approver returns the record to the PI, the PI receives a notification. The approver’s comments 

are included in the notification.  

 

 

 

 

To open the record requiring further information: 

1. Click Dashboard. 

2. Click Post-Award/Projects requiring further information from PI (for approver) in the Things to 

do list.  

3. Click the blue hyperlinked 

title to open the record. 

 

 

To respond to approver comments:  

1. Click the Approvals tab. 

Comment from 

the approver 
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2. Click the         icon beside 

the approver’s name to 

view the comments page. 

 

 

 

 

 

 

3. Review the Approver Comments.  

4. Enter response to approver in the Note to approver(s) box. 

5. Click Save & set status. 

6. Select Return to PI for further 

information. 

7. Click Save & Set Status. 

8. Update RMS record with 

information requested. 

 

 

 

 

 

To resubmit the updated record for approval: 

1. Click Save & Progress. 

2. Select Submitted for Approval. 

3. Click Save & Set Status. The approval status for the approver who requested additional 

information will change to Pending Approval.  
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NOTIFICATIONS: SEND AND REPLY 

Contacts listed in an RMS record can be sent a notification from within RMS wherever the      icon is 

displayed. Sent notifications from within RMS, are not saved in the Notifications inbox. 

To send a notification: 

1. Navigate to the Contact field (e.g., PI, Team Member, Co-Investigator, Designate, or Grants 

Officer). 

2. Click the       icon in the right column 

beside the contact’s name. The 

notification template opens. 

3. Select the Priority  

4. Add the Subject.   

5. Add the message into the Body.  

6. Click Send.  

 

To reply to a notification: 

1. In the left menu, click Notifications.  

2. Select the message you want to reply to by clicking on the hyperlinked message.  

 

 

 

3. Then click Reply.  

 

4. Type your reply message in the Body field. 

 

5. Click Send.  


